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The "Live Configs" is a Simple & Mighty tool made for live performers by live performers. 

It is France's second most important export after Champagne. 
 

1) Foreword about “live” 
 

Many things to say about “computer-based live performances”: many point of views, many possible setups, drawbacks, 
advantages, hardware constraints, etc.. This document just deals with one software solution. It describes one typical setup 
example and step-by-step procedures to configure it. 
Also, as the wording “live” is used for very different things, the scope of this tool/document can be simply clarified: 

 Sound engineers mixing a band (or something) live 

 “Playback-based” software, like live step sequencers, etc.. 

 Using the computer as an FX processor, just like a pedal effect ← here we are: on stage! 
 
Reliability? About software: a close version of this tool is used on tour and validated on Win 7 64-bit & Win XP 32-bit 
(REAPER v3.73, see 6). About hardware: there are many issues one can face on stage (vibrations, voltage drops in outdoor 
festivals, the drunk factor, etc..) but they are not addressed in this document. Well, just keep in mind the golden rule:  
“I must have a backup solution ready to go - even if totally degraded!”  
Note: if you are interested in advanced solutions like automatic HW fail-over management, get in touch! ($) 
 

2) Live Configs!? What is it? 
 

As said above, we are on stage! So we do not care about the keyboard, the mouse or things like that. We just want to plug 
things, boot the computer and play the guitar (or keys or both: it works the same for audio and MIDI). 
 

We just need a MIDI controller to change “configs” while playing: a fader, a knob, an expression pedal or +/- pedals. 
“Changing configs” means changing effects (VST/VSTi, AU, ..), FX presets, routings, triggering actions, etc…. well, anything but 
in a smooth and glitch-free way. 
 

 
The "Live Configs" tool is a REAPER extension plugin (it is not an audio/MIDI plugin -like VST, it only works within REAPER). 
 

REAPER is a Digital Audio Workstation: http://www.reaper.fm/download.php (free evaluation download). 
It is rock solid software. This document assumes you know REAPER already so if something is not clear for you, please have a 
look on its excellent user manual: http://www.reaper.fm/userguide.php. 
 

The “Live Configs” tool is part of the SWS/S&M extension plugin which is free as in beer and free as in speech.  
This document refers to the version v2.1.0 #30. The last/up-to-date version of the extension plugin is available here:  

http://code.google.com/p/sws-extension/downloads/list. 
 

Both REAPER and the SWS/S&M extension run on Windows XP/Vista/7 (32-bit and 64-bit), OSX 32-bit (10.4-10.7), OSX 64-bit 
(10.5-10.7) and OSX PPC (10.4-10.5).  

 
 

 
  

http://www.reaper.fm/download.php
http://www.reaper.fm/userguide.php
http://code.google.com/p/sws-extension/downloads/list
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3) Typical setup example: simple, efficient 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Of course, even if limited, there are solutions without the Live Configs too! 
 

For MIDI, you can simply route the input track to other tracks containing VSTis: nothing is muted but one instrument is being 
played at a time thanks to distinct MIDI channels. You are obviously limited to 16 configs in this case and you can face “stuck 
notes” when switching instruments… 
 
Opened. As you can see, the idea is to let you define the setup you want. The tool will not mess with your project. It is up to 
you to define tracks, routings, FXs, etc.. It is up to you to use an “input track”, or not. It is up to you to automatically mute 
things, or not. Etc.. 
 
A final advice about setups: the simpler, the best! 1 2 

                                                 
1
 Live Configs are saved in REAPER project file (.RPP). You just need to configure things once and use this project when starting REAPER, this can be 

automatic: see 6). 
 

2
 Live Configs will only deal with configured tracks. All other tracks of the project file will remain untouched and thus can be used for other matters 

(or in other Live Configs, i.e. several controllers or musicians on the same computer). With our example above, it means that tracks #1 to #16, #18, 
#19 as well as all other tracks > #24 can be used for other matters. 

Here is one example we will detail: when it is started, REAPER automatically loads 
our project file¹ which contains an “input track” (i.e. an armed track without 
“Master/parent send”) and all the FX we need on tracks 20 to 23 (or more). The 
MIDI or audio input is simply routed from the input track 17 to those tracks. 
 
Now, here is the big picture when changing configs:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Simple, efficient: all tracks and routings that are part of the config² are muted 
except the active one! The main advantages of this solution are: immediate and 
seamless switching between configs (no disk access during switches: everything is 
already present in the project file + the tool obeys the REAPER preference > Audio 
> Track mute fade) as well as CPU savings (see 6). 
 
Again, this is just an example: there are many possible setups! 
 

Here is another example without any “input track” (nor routing): the track is 
simply armed/unarmed when activated/deactivated. 
We can also imagine some tracks being re-configured with FX chains or track 
templates files: less RAM usage but longer switches due to disk access + effect 
instantiation time (might be interesting for large sample-based effects though), or 
more complicated setups like a track containing everything and being reconfigured 
by disabling all FXs but the active one, etc…  

MIDI or audio send 

MIDI or audio input 

Muted  

 

 

 

 

 

 

 

 

 

 

 

 

Track 17 

Input track 

Track 20 
No FX (default) 

Track 21 
FX a 

Track 22 
Bridge 

Track 23 
FX b 

 

etc… 

 

etc… 

Track 20 
No FX (default) 

 

Track 21 
FX a 

Track 22 
FX b 

Track 23 
FX c 

 

 

 

 

 

 

Out of 
config 
tracks 
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4) REAPER > Main menu > Extensions > Live Configs 
 

 
 

 
 
Columns: 
1. CC value that will activate the row’s config, see.5). 

Double-clicking a cell in this column will activate the 
related config (useful to test things). The last 
activated config is tagged with the character * (e.g. 
row #006 above). This column is not editable. 

2. Track (optional). All tracks of the current project are 
available in the cell’s context menu. 

3. User comment. Double-click to edit it. 
4. Track template file (optional). A target track must be 

defined in column 2 then a file can be chosen via the 
context menu or by double-clicking a cell. 

5. FX Chain file (optional). A target track must be 
defined in column 2 then a file can be chosen via the 
context menu or by double-clicking a cell. 

6. FX user presets (optional): user presets defined in 
.rpl files (as opposed to patch/bank .fxp/.fxb files) 
so that it works for all FX types, not only for VST 
plugins. A track with target FX(s) must be defined 
in column 2, all its FXs and user presets are then 
listed in the cell’s context menu. 
This feature/column is not yet available on OSX. 

7. Action or macro that will be performed when 
activating the row’s config (optional). On Windows 
OS, a command “Learn from Actions window” is 
available in the context menu. You can also 
double-click a cell to enter a “Command Id” or a 
“Custom Id”, see next page. 

8. Action or macro that will be performed when 
deactivating the row’s config (optional). Also see 
column 7’s comments. 

A. Displayed config number 
Up to 8 configs can be used simultaneously but only one 
can be displayed at a time in the “Live Configs” window. 

 

Options of the displayed config: 
B. Enables/disables the current config. Learned MIDI CC 

messages are ignored when disabled. There are actions 
to toggle the current config too, see 5) 

C. Mute all but active track (and receives from the input 
track, if it is defined), see 3) 

D. If it is defined, the row’s track will be automatically and 
exclusively selected when activating/deactivating the 
related config (useful for actions/macros as many of 
them deal with selected tracks). 
Note: track selection is changed during the switch and 
restored immediately after (i.e. may not be even visible!) 

E. Input track (optional) , see 3) 

 
Defining configs is quite straight forward: everything is done through the context menu (which is “cell-dependent”).  

7 8 

B C D E 

3 4 2 1 5 6 

A 
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Configs: step-by-step example 
 

Ok, let’s configure something like the row “002” shown in the previous page: 
 

 
 
This config will activate the track 21 “DistoAmp” which contains 2 FXs. We will also set presets for both FXs and actions to unbypass the 2nd FX when the config is activated 
and another one to bypass it when the config is deactivated (in other words, the 2nd FX is only used for that config 002). 
 

 Right-click the cell at row 002 / column “Track” 
→ a context menu proposing all tracks found in the project is displayed 

 Choose a track 
 → the cell is updated with the chosen track 

 

Most of the time, this is enough (with the option “mute all but active track”) but we also select FX presets here… 
 

 Right-click the cell at row 002 / column “FX user preset”  
→ a context menu proposing all FXs found in the track you have chosen above is displayed 
→ and, for each FX, a submenu proposes all available user presets 

 

Note: the popup will have grayed items if there is a problem. For example “No FX”  
or grayed FX name if no user presets are defined for it (load/make a RPL file first!) 
 

 Choose a preset 
→ the cell is updated with the chosen user preset 

 

We repeat the preset selection for the 2nd FX… 
Activate/deactivate actions example now: 2 ways you can do it depending on your OS… 
 

 On OSX or Windows OS: 
o Double-click the cell at row 002 / column “Activate action” 
o Enter the “Command id” or with the “Custom id” you want 

 On Windows OS: 
o Open the “Actions” window and select the action you want 
o Right-click the cell at row 002 / column “Activate action” 

→ a context menu is displayed  
o Choose “Learn from Actions windows” 

→ the cell is updated with the learned “Command id” or “Custom id” 
 
Command id? Custom id!? What is it? 
They are action identifiers used in REAPER. You can find them in the “Actions” 
window (if you cannot see some of the columns shown here, right-click the table 
header to display them): 

 “Custom ids” for macros and extension actions (like SWS/S&M ones) 

 “Command ids” must be used for native actions 
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5) MIDI Controller & Learn 
 

Configs are smoothly activated thanks to a MIDI controller (a knob, a fader, an expression pedal, etc..). The important thing is 
that only the last "stable" MIDI message is processed. In other words, a config will be activated only when you have finished 
tweaking the knob/pedal (and not while you are tweaking it)3.At the moment, only controllers with absolute MIDI Control 
Change (CC) messages are supported4. Fortunately, this is the main type of controller. 
 

Unlike REAPER’s macros5, the tool uses data values of CC messages. Example: say you have learned the live config #1 with 
CC#4 → CC#4 value 10 can trigger one config (say a FX preset), CC#4 value 11 can trigger another config (say loading a FX 
Chain), CC#4 value 12 can trigger a third config (say performing a custom macro), etc.. 
 
Learn: step-by-step procedure  
Ok, we want to learn (i.e. “attach to a MIDI controller”) the live config #1: 
 

 Open the Actions window, select the section “S&M Extension” (and not the “Main” one!) 
 

 

 

 Select the action SWS/S&M: Apply live Config#1 (MIDI CC absolute only)” 

 Click on “Add” 
→ a window “Keyboard or MIDI input” is opened 

 Move your controller  
→ the learned CC# appears 
 

 
 

 Click OK 
→ Done 

 
  

                                                 
3
 It is not what live performers will want but it is also possible to process all MIDI messages while tweaking a controller: exit REAPER and set 

"CC_DELAY" to 0 in the section [LIVE_CONFIGS] of the S&M.ini file. To find this file: REAPER > Main menu > Options > Open resource path in 
explorer/finder. 
 

4
 Alternatively, you can also use two Note-On MIDI messages and learn the following actions of the “Main” section: “SWS/S&M: Live Config #n – 

Next” and “SWS/S&M: Live Config #n – Previous” (only the last "stable" config will be activated too). 
 

5
 You cannot use such CC values in macros. With the above example, the same macro is triggered whatever is the value of the CC#4 message. 
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6) Important recommendations 
 

 Please use REAPER v3.73! When applying track templates or FX chain files, there are possible audio glitches with 
REAPER v4. This problem is under investigation (Cockos’ hand needed…). Anyway, that is not really bothering since 
we only use REAPER’s audio engine, not its new editing features… Well, for Win 7 and our “live” context, the only 
annoying thing would be the WASAPI support (low latency) but it is still tagged as “experimental” and reported as 
glitchy by some users: http://forum.cockos.com/showthread.php?t=81862 (it is fine here, though). 

 REAPER > Preferences > Audio > Close audio device *…+: all disabled 
→ We want to use the audio engine whatever happens 

 REAPER > Preferences > Audio > Buffering > Allow live FX multi processing: enabled + set the proper number of CPUs 

 REAPER > Preferences > Audio > Playback > Run FX when stopped: enabled 

 REAPER > Preferences > Audio > Track mute fade: set the 100 ms there 
→ The tool obeys this preference when it activates configs (smooth switching) 

 REAPER > Preferences > Audio > Do not process muted tracks: enabled 
→ CPU savings when the Live Configs’ option “mute all but active track” is enabled 

 REAPER > General > Maximum undo memory use: 0 (i.e. undo disabled) 

 REAPER > Main menu > Extensions > SWS Options: disable everything there 

 Audio/MIDI plugins: if you face some issues, contact the author for a bug fix. no fix => quarantine (I personally do not 
advice bridging buggy plugins: some features of the Live Configs like preset switching will not be supported).  

 
As these options are not really compatible with song edition, you can start REAPER with dedicated live settings (i.e. a “live 
edition” of the REAPER.ini file) thanks to a command line like: 
reaper -cfgfile ReaperLive.ini myLiveConfigs.rpp6 

 

7) Other tools for live performers 
 

It can be useful to switch between project tabs or to load projects sequentially: the “S&M Project loader/selecter” tool and 
actions can interest you, details here: http://forum.cockos.com/showpost.php?p=831103&postcount=655. 
 

Those actions of the “Main” section can be useful too: 

 SWS/S&M: Toggle Live Config #n enable 

 SWS/S&M: Live Config #n – Next 

 SWS/S&M: Live Config #n - Previous 
 

A VST REAPER extension “MIDItoReaControlPath” can help too, see: http://forum.cockos.com/showthread.php?t=43741. 
It routes MIDI messages from the standard path (i.e. tracks) to the control path (i.e. automation/learn) so it allows you 
reprocessing your controller MIDI messages (typical example: triggering 2 different live configs but with a single controller). 
 

8) Contact, donate, feedback & thank yous 
 

I am “Jeffos” on the REAPER user forums. You can contact me there (private message). 
Donations are welcome, the PayPal link here: http://reaper.mj-s.com 
 

Bugs (if any) should be reported in the SWS issue tracker: http://code.google.com/p/sws-extension/issues/list 
For obvious reasons, I am highly committed to fix them! 
 

You can post feedback and questions about the Live Configs tool in its dedicated discussion thread: 
http://forum.cockos.com/showthread.php?t=96289 
 

Thank yous 
I would like to acknowledge here the fantastic work of REAPER developers. I would also like to thank the talented 
Tim Payne (SWS) for his incredible French skills, his technical support and for saving my OSX butt a hundred times (at least). 
 
Jeffos – February 2012 

                                                 
6
 of course, you make a .BAT file and move it in the “Startup” directory: the PC will boot with your live settings and the correct project file. 

http://forum.cockos.com/showthread.php?t=81862
http://forum.cockos.com/showpost.php?p=831103&postcount=655
http://forum.cockos.com/showthread.php?t=43741
http://reaper.mj-s.com/
http://code.google.com/p/sws-extension/issues/list
http://forum.cockos.com/showthread.php?t=96289

